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Chapter 1: How Do I Start Using ACT!?

After you install ACT!, you need to create a database to store information about the people you want to track. You can

use the Setup Assistant to create the database, set options (called "preferences") for working in ACT!, integrate ACT!

with Microsoft® Outlook®, and more.

Then, you can:

● Add contact records by importing them or by manually adding them.

● Organize your contacts into groups.

● If you have several contacts who work for the same company, create a company record so you can easily update

information for all contacts at once.

● Schedule appointments (activities). These might be meetings, calls, or to-do’s.

● Review histories of meetings, e-mails messages you have sent, and so on.

● Add notes to the contact record about anything you need to remember.

● Track progress in making sales.

This guide will help you to understand the basics to getting started with ACT!. In this chapter, you will learn about the

Setup Assistant and about other resources for learning about ACT!.

About the Setup Assistant

When you open ACT! for the first time, the Setup Assistant appears. You can use this wizard to create a database and

set default preferences and other options so you can quickly start managing your contacts and information.

Using the Setup Assistant, you can:

● Create a new database or convert an ACT! 3.x, 4.x, 5.x (2000), or 6.x (2004) database.

● Access the E-mail SetupWizard to set up e-mail systems to work with ACT!.

● Select options for integrating Microsoft Outlook e-mail and calendars with ACT!.

● Select a word processor to use with ACT!.

The Setup Assistant is also available from the Help menu and on the Welcome page under Getting Started. Click Set Up

Preferences and E-mail. (The Welcome page is discussed in the next section.)

Resources for Learning About ACT!

Most people learn how to use an application by experimenting with it. You can:

● Click the buttons on the Navbar (located on the left side of the ACT! screen) to see the views that display.

● View the Welcome page that gives you quick access to common resources, tips on using ACT!, and where to go

when you need in-depth help. From the Navbar, click Welcome. By default, the Welcome page is set as the startup

view that appears when you first open ACT!, but you can change that preference. For more information, see Help.

● Explore the menus and toolbars.

● Read this Quick Start for New Users.

● Click the Help Topics button or the Help menu.

● View the tours for various features. See the section ACT! User Assistance for more information about tours.

There are several ways to perform a task other than those given in the Quick Start for New Users and Help. For example,

the documentation may direct you to select a command from a menu, but you may also click a toolbar button or a

Related Tasks link. Find the method that works best for you.
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Using the Demonstration Database

Using the Demonstration Database

You may want to practice entering data using the demonstration database, ACT2010demo, which is installed with

ACT!. This database contains sample records and activities.

Steps: Open the Demonstration Database

1. Do one of the following:

● If you do not have a database open: From the global toolbar, click Open Database, or from theWelcome

page (under Getting Started), click Explore the Demo Database.

● If you have a database open, from the Filemenu, click Open Database.

2. Double-click ACT2010demo.pad.

3. If prompted, log in as Chris Huffman. No password is needed.

ACT! User Assistance

The following items will help you learn about the software. You may have received print versions of some of these

items when you purchased ACT!.

Administrator’s Guide

The Administrator's Guide explains how to plan for, set up, and configure user access to ACT! Premium for Web. It also

provides information for securing the application and troubleshooting solutions. The Administrator’s Guide is available

as a PDF from the ACT! Premium for Web product DVD and the ACT! Premium for Web server application's Help

menu.

Installation Guide

The Installation Guide explains how to install, register, and activate ACT!. You should read this document before

installing the software. The Installation Guide is usually printed, but it is also available as a PDF from the product DVD.

Quick Reference Card 

The Quick Reference Card provides tips for navigating ACT!, adding information to your database, scheduling meetings,

calls, and to-do's, communicating with contacts, working effectively, and sharing information.

You may have received a printedQuick Reference Card, but it is also available as a PDF from the ACT! Help menu.

Select Online Manuals, then select ACT! Quick Reference Card.

Feature Tours

Tours walk you through scheduling activities, working with opportunities, using groups and companies, installing

handheld links, using Dashboards, and more. Several tours are available from the Welcome Page and all are available

from the Help menu. To see a list of all tours, see "Feature Tours" in Help.

Accessing the ACT! Knowledgebase

Knowledgebase articles on the Knowledgebase page of the ACT! Web site (www.act.com) explain how to resolve

errors you may experience, unexpected behavior in the application, and more.

Steps: Access the ACT! Knowledgebase

● From theWelcome page, under Support & Services, click Online Knowledgebase.
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Chapter 2: What Is in the ACT! Workspace?

In this chapter, you will learn about the information you can put in ACT! and the ways ACT! displays that information.

To view a tour of the ACT! workspace, from the Welcome page, under Video Tutorials, click ACT! Workspace.

What Kind of Information Can I Put in ACT!?

In ACT!, the main types of information are:

● Contacts

● Groups

● Companies

● Activities (appointments, meetings, and tasks you need to schedule)

● Opportunities

You can organize and track many kinds of information relating to the people you do business with, such as customers,

prospects, and vendors. You can also track the other people in your life, such as doctors or friends. The people you

keep track of are called contacts.

You can organize your contacts into groups (for example, everyone who is working together on a project). You can

work with everyone in the group at once, such as setting up a meeting (scheduling an activity) with the group instead

of each contact. You can create a company record if several of your contacts work together. Then, you can link the

contacts to the company and automatically update information between the contact and company records.

For more information about contacts, groups, and companies, see "How Do I Keep Track of Contacts?" on page 13.

You can organize your schedule using ACT!'s activities and calendars. For more information about activities and

calendars, see "How Do I Schedule Appointments and Tasks?" on page 19.

Opportunities let you track, manage, and report on your prospective and closed sales and revenue transactions. For

more information, see "How Can I Track My Sales?" on page 29.

How Information Appears in ACT!

You enter information into ACT! views, which are basically forms. You can view the information of one contact or sale

at a time or in lists of related items.

The following sections explain some of what you will see in ACT!, such as:

● The common items in the workspace: navigation bar, menus, and toolbars

● Contact views

● Group views

● Company views

● Opportunity views

Other ACT! views, such as Dashboards, Reports view, Calendar, and Task List are explained in other chapters of this

guide.

Navigation Bar, Menus, and Toolbars

All views in the ACT! workspace include the navigation bar, menu bar, and two sets of toolbars. These items are

explained in the following sections.

Navigation bar

The navigation bar (Navbar) appears on the left of any view. It contains the primary navigation buttons for opening

ACT! views, a search function, and a view-specific Related Tasks area. The Related Tasks area makes it easy for you to

see and access tasks for a view. You can collapse the Navbar and add or remove navigation buttons (commands) from

it.
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Learning About Contact Views

Menu bar

The menu bar is located at the top of all ACT! views. The menu bar contains the default ACT! menus and commands.

Depending on the view, some menu commands are active and some are not. For example, if you are on the Group

Detail view, some of the Schedule menu commands are not active. Also, some top-level menu items change depending

on the view. For example, if you are on the Group Detail view, the Contacts menu command does not display. You

would need to switch to the Contacts views to see the Contacts menu.

You can customize the menu bar to display only the menus and commands you need. You can also create custom

menus.

Toolbars

ACT! has two sets of toolbars – the global toolbar and the view toolbar. The global toolbar is located below the menu

bar. It has large buttons for commands used most frequently in every ACT! view. The global toolbar cannot be

relocated or undocked from its location. You cannot customize the global toolbar.

The view toolbar is located at the top of every ACT! view. It displays commands (tools) for tasks related to the view,

the buttons to switch between the Detail View and List View for contacts, groups, companies, and opportunities, the

Dashboard selector (Dashboards are explained later in this guide), and the layout selector. The layout selector changes

the Detail layout that appears, which affects the background color, fields, and so on. ACT! includes two default layout

sizes: 800 x 600 and 1024 x 768. The layout size may affect where fields and tabs appear.

You can:

● Modify the view toolbar by adding or rearranging your favorite tools.

● Remove tools that you rarely use.

● Create custom toolbars.

For more information about customizing the workspace, see Help.

Learning About Contact Views

Contact views include the Contact Detail view and the Contact List. The information you can enter or see depends on

the view you choose. You can switch between different ACT! views from the view toolbar.

Contact Detail View

You enter and view information about one contact on the Contact Detail view. The Contact Detail view is a form,

called a layout, which has fields and tabs that you can customize. The top portion of the default Detail view contains the

fields for basic business information, such as contact name, work address, telephone numbers, status, and other details.

The Contact Detail view has its own view-specific toolbar and layout selector. A counter in the view toolbar shows the

number of contacts you can access. The arrow buttons let you view the first, previous, next, or last record. If you

search for specific records (for example, by using a lookup or search), the counter reflects the set of records instead of

the number of contacts in the database. For more information about lookups and searches, see "How Do I Find

Information?" on page 25.

Note:Most fields on the Detail View are self-explanatory. In some cases, you cannot type in a field because it is

automatically updated in ACT!. For more information about these fields, see "Fields You Cannot Change" in Help.

You use the Detail tabs (located at the bottom portion of the view) to enter, view, and locate additional information

about the contact. These tabs let you:

● Enter information, such as business requirements, about the contact (Notes).

● View and schedule appointments with the contact (Activities).

● FindWeb information, such as a LinkedIn® profile, for the contact (Web Info).

● View the history of e-mails sent and changes to the contact's information (History).

● Attach documents, such as Microsoft® Excel® spreadsheets, to the contact (Documents).

● View and open prospective/won sales transactions (Opportunities).

● Create and manage relationships for the contact (Relationships).

4 ACT! by Sage 2010

../../../../TechPubs_Head/ACT! 11.0 Help/Content/Security/What Is Record Access.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Activities/Learning About the Activities Tab.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Activities/Learning About the Activities Tab.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Activities/Learning About the Activities Tab.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Activities/Learning About the Activities Tab.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Internet/Learning About Web Info.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Internet/Learning About Web Info.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Internet/Learning About Web Info.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Communications/Documents Tab/Learning About the Documents Tab.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Communications/Documents Tab/Learning About the Documents Tab.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating and changing contact relationships.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating and changing contact relationships.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating and changing contact relationships.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating and changing contact relationships.htm


Learning About Group Views

Tip: The default Contact Detail view layout has several other tabs. Click them to see the features and functions you can

do for a contact.

From the Contact Detail view, some of the functions you can do are:

● Add, edit, or delete contacts.

● Find contacts using a lookup.

● Duplicate a contact record.

● Click a contact's e-mail hyperlink to send an e-mail message.

Contact List

The Contact List displays the data contained in the fields on the Contact Detail view in columns which you can sort,

move, or hide. By default, the Contact List shows all contacts you can access.

You can perform many of the same functions in the List view as you can in the Detail view. From the Contact List, you

can also:

● Use Edit Mode to change information for one or more records. This way, you do not need to open a Detail view to

make a change.

● Use Tag Mode to tag, or mark, contacts. Then, you can work with just those contacts.

● Export the data to Excel. The columns and data are exported as they appear in ACT!. You must have Excel version

2002 (XP), 2003, or 2007 installed.

You can change the appearance of the List and the data it contains by:

● Adding, moving, or removing columns.

● Resizing columns.

● Sorting records.

● Changing the text color or font.

Learning About Group Views

Like contact views, group views include the Group Detail view and the Group List. The information you can enter or

see depends on the view you choose. You can switch between different ACT! views from the view toolbar. Unlike

contact views, the Group Detail view also contains the Groups tree.

Group Detail View

You can enter and view information about one group on the Group Detail view. Like the Contact Detail view, the

Group Detail view is a layout which has fields and tabs that you can customize. It has its own view-specific toolbar and

layout selector.

The Group Detail view has tabs, just like the Contact Detail view. You can use these tabs to add, view, and manage

information about the group.

From the Group Detail view, you can: 

● Create groups and subgroups.

● Add or remove contacts as members of groups.

● Find groups using a lookup.

Groups Tree

The Groups tree appears in the Group Detail view and it displays the hierarchy of groups and subgroups. The number

of groups and subgroups appears at the top of the tree. Groups appear in alphabetical order with their subgroups

below them, also in alphabetical order. 

In the Groups tree, you can:

● Show subgroups by clicking the plus sign. The plus sign changes to a minus sign. Click the minus sign to collapse the

display.
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Learning About Company Views

● Add or change information by selecting a group or subgroup.

● Move groups and subgroups in the tree. You can change a group to a subgroup or promote a subgroup to a group.

For more information about the Groups tree, see Help.

Group List

Like the Contact List, the Group List displays the data contained in the fields on the Group Detail view in columns

which you can sort, move, or hide. By default, the Group List shows all the groups you can access.

You can perform many of the same tasks in the List view as you can in the Detail view. From the Group List, you can

also:

● Attach a file, or shortcut to a file, to one or more groups.

● Create a lookup of contacts for selected groups.

● Use Edit Mode to change information for one or more records. This way, you do not need to open a Detail view to

make a change.

● Export the data to Excel.

Learning About Company Views

Like group views, company views include the Detail view, the Companies tree, and the Company List. The

information you can enter or see depends on the view you choose. You can switch between different ACT! views from

the view toolbar.

Company Detail View

You can enter and view information about one company on the Company Detail view. Like the Contact and Group

Detail views, the Company Detail view is a layout which has fields and tabs that you can customize. It has its own

view-specific toolbar and layout selector.

The Company Detail view has tabs, just like the Contact Detail view. You can use these tabs to add, view, and manage

information about the company.

From the Company Detail view, you can:

● Create companies and divisions.

● Link contacts and companies.

● Find companies using a lookup.

● Find information specific to a company using the Web Info tab.

Companies Tree

The Companies tree appears in the Company Detail view and it displays the hierarchy of companies and divisions. The

hierarchy is all companies and its divisions. The number of companies and divisions appears at the top of the tree.

Companies appear in alphabetical order with their divisions below them, also in alphabetical order. 

In the Companies tree, you can:

● Show divisions by clicking the plus sign. The plus sign changes to a minus sign. Click the minus sign to collapse the

display.

● Add or change information by selecting a company or division in the tree. Then, right-click to open a command

from the menu.

● Move companies and divisions in the tree. You can change a company to a division or promote a division to a

company.

For more information about the Companies tree, see Help.

Company List

Like the Contact List, the Company List displays the data contained in the fields on the Company Detail view in

columns which you can sort, move, or hide. By default, the Company List displays all companies you can access.

6 ACT! by Sage 2010

../../../../TechPubs_Head/ACT! 11.0 Help/Content/Groups/Moving Groups in the Hierarchy.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Lookups/Creating Contact Lookups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Lookups/Creating Contact Lookups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Lookups/Creating Contact Lookups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Lookups/Creating Contact Lookups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Lookups/Creating Contact Lookups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Import_Export/Exporting Data to Excel.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Import_Export/Exporting Data to Excel.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Import_Export/Exporting Data to Excel.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Moving companies in the hierarchy.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Security/What Is Record Access.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Security/What Is Record Access.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Security/What Is Record Access.htm


Learning About Opportunity Views

You can perform many of the same tasks in the List view as you can in the Detail view. From the Company List, you

can also:

● Use Edit Mode to change information for one or more records. This way, you do not need to open a Detail view to

make a change.

● Add contacts to a company.

● Attach a file, or shortcut to a file, to one or more companies.

● Create a lookup of contacts for selected companies.

● Export the data to Excel.

Learning About Opportunity Views

Like contact views, opportunity views include the Detail view and the Opportunity List. The information you can enter

or see depends on the view you choose. You can switch between different ACT! views from the view toolbar.

Opportunity Detail View

You can enter and view information about one sales opportunity on the Opportunity Detail view. Like the Contact

Detail view, the Opportunity Detail view is a layout which has fields and tabs that you can customize. It also has its

own view-specific toolbar.

The top portion of the Opportunity Detail view contains the fields for basic opportunity information as well as a status

indicator, sales totals, number of days open, and an Association box. The Association box lists contacts, groups, and

companies associated with the opportunity.

A counter at the top of the Opportunity Detail view shows the number of opportunities you can access. The arrow

buttons let you view the next, previous, first, or last record. If you search for specific records (for example, by using a

lookup, search, or filter), the counter reflects that set of records instead of the entire database.

The Opportunity Detail view has some of the same tabs as the Contact Detail view as well as its own tabs, such as the

Products/Services tab. This tab lets you track and manage products and services for the opportunity.

From the Opportunity Detail view, you can: 

● Open and manage opportunities.

● Add products or services to an opportunity.

● Associate contacts, groups, or companies with opportunities.

● Find opportunities using a lookup.

● Create a quote for the opportunity.

Opportunity List

The Opportunity List displays the data contained in the fields on the Opportunity Detail view in columns which you can

sort, move, or hide. By default, the Opportunity List shows all sales opportunities you can access.

You can perform many of the same tasks in the List view as you can in the Detail view. From the Opportunity List, you

can also: 

● Filter the list by date, status, stage, weighted or grand total, and other filters, so that you can see focused "snapshots"

of prospective sales and where they are in the sales pipeline.

● Create a lookup of contacts for selected opportunities.

● Create opportunity pipelines or graphs to help you forecast and report on your sales.

● Export the data to Excel.
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Chapter 3: How Do I Get Information into ACT!?

In this chapter, you will learn about:

● ACT! databases.

● How to create a database.

● How to import information into a database.

Databases

In this section, you will learn: 

● About databases.

● About the Administrator for the database.

● How ACT! uses "My Record".

● How to create a database.

Learning About ACT! Databases

To use ACT!, you must create a database to store your contact information, including names, addresses, and telephone

numbers. You can track and manage other information for your contact records, such as scheduled appointments, e-

mail messages, and correspondence.

If you want to share the information with others, you can set them up as Users in the database. You can share the

database, so you can schedule appointments with others and assign records to them. To share the information with a

remote office or employee, you can create a remote database and set up database synchronization.

You can back up and restore a database. See Help for more information.

The Database Administrator

When you create a new database, you usually enter your name as the first user. The first user is automatically set up as

the database administrator with the Administrator security role. (For more information about users and security roles,

see Help.) This step also creates a contact record called My Record. You can add your address, telephone number, and

other information into this contact record.

How Does ACT! Use "My Record?"

Each user of the database has their own "My Record." ACT! uses the information from this record in several ways,

including when you:

● Schedule appointments, meetings, or tasks.

● Send e-mail messages or letters to several contacts.

● Create or change word-processing or report templates. (You can include fields from your My Record in the

template.)

● Print information or run reports.

Creating Databases

The following explains one way to create an ACT! database. If you know others will need access to the data, you can

share the database. Once the database is created, you add the people requiring access as Users.

Steps: Create a database

1. From the Filemenu, click New Database.

2. In the Database name field, type a name for the new database.

The name must begin with a letter. Do not include spaces or punctuation.

3. In the Location field, keep the default information.

or

To save the database to a different location, click Browse to browse to the location. Click OK.
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Import Data

4. In the Currency field, from the list, select a currency for the database.

5. To share the database with others, select the Share this database with other users check box.

6. In the User name field, type a user name for the database. (This step creates a contact record known as My

Record and in most cases, this will be your name. This contact is given the Administrator security role.)

7. To set a logon password for the database, in the Password field, type a password and type in again to confirm.

Caution: If you forget this password, you will not be able to access the database. You will have to contact

Technical Support.

8. Click OK.

ACT! creates the database and a file that points to the database. This file has a PAD extension. If you share

the database with others, you can send them a shortcut to the PAD file so they can access the database.

Tip: For more information, see "Sharing Databases" in Help.

Import Data

In this section, you will learn about:

● Importing data.

● Using the Import Wizard to import information.

Note: Importing data from files you already have is a quick way to get started using ACT!. If you do not want to

import data, but will manually add contacts, see "Adding Contacts" on page 13.

About Importing Data

You can import data from other ACT! databases and sources. Some applications, such as Microsoft Outlook, let you

import appointments, notes, journal entries, or tasks. Most other sources only let you import contact data.

Using the Import Wizard, you select the file that data will import from, the type of records to import, and the merge

options for the imported data.

Tip: Read the following topic in Help before you import data to an ACT! database: "Data Import and Export Tips".

To view a tour for this feature, from the Help menu, point to Feature Tours, and then click the tour name.

Using the Import Wizard

The following explains how to use the Import Wizard to import data from a source other than ACT!, such as Microsoft

Excel or Outlook.

Tip: To see a scenario about importing a contact list, go to "Scenario - Importing Contact Lists" in Help.

Steps: Import data from other sources

1. Open ACT!.

2. From the Filemenu, click Import.

3. Follow the instructions on the Import Wizard pages. Click Next to advance.

Note: You can import only one record type at a time, such as contacts. Some programs may only have contact

records.

4. Click Finish.

5. Repeat the process to import other record types.
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Chapter 4: How Do I Set Up ACT!?

In this chapter, you will learn about:

● How to set preferences to make ACT! work the way you want.

● How to set up your e-mail system.

● How to select a word processor for writing letters and documents.

Preferences

In this section, you will learn about the preferences and options you can set for how ACT! works.

What Are Preferences?

Preferences let you set up ACT! and customize it to fit your work style. You can set preferences to:

● Set up E-mail and set an option to record history of e-mails sent.

● Select a word processor (ACT! Word Processor or Microsoft Word) to use with ACT!.

● Customize name and salutation settings for contacts.

● Determine how contact names display on calendars.

● Specify a default priority, duration, and notification for activities.

If you log on to ACT! from another computer, most preferences still apply.

Preferences are set from one of the following tabs in the Preferences dialog box:

● General

● Colors & Fonts

● Calendars & Scheduling

● E-mail

● ACT! E-mail Editor (if you use ACT! E-mail)

● Communication

● Startup

For information about setting preferences, see Help.

E-mail Setup

In this section, you will learn about:

● E-mail systems you can use with ACT!.

● Using Microsoft Outlook.

● Setting up an e-mail system.

E-mail Systems You Can Use with ACT!

You can use one of the following e-mail systems with ACT!.

Note: If you do not have one of these e-mail systems installed on your computer, you may be able to use an Internet

mail account to send mail from ACT!.

● Eudora® version 5.2

● Lotus Notes® versions 6.5, 7.02, and 8.0

● Microsoft Outlook Express 6.0 (SP2)

● Microsoft Outlook 2002 (XP) (SP3), 2003 (SP3), or 2007

Caution: Eudora, Lotus Notes, andMicrosoft Outlook Express limit some e-mail functionality in ACT!.
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About Using Outlook E-mail

About Using Outlook E-mail

You can set up Microsoft Outlook as the default e-mail system to write, send, and work with e-mail in ACT!. You must

have Outlook version 2002 (XP), 2003, or 2007 installed on your computer.

If you choose to use Microsoft Outlook, you can use it with ACT! E-mail or instead of ACT! E-mail. 

● If you use Outlook with ACT! E-mail, you manage, view, and send e-mail messages using the ACT! E-mail system.

● If you use Outlook instead of ACT! E-mail, you manage, view, and send e-mail messages using Outlook.

For more information about how e-mail is different when using Outlook, see Help.

Note: If you use Outlook e-mail, during e-mail set up in ACT!, you must select to access Outlook e-mail through the

ACT! E-mail system or direct integration with Outlook.

Setting Up E-mail

The following explains how to set up an e-mail system to use with ACT!.

Steps: Set up e-mail

1. From the Tools menu, click Preferences.

2. In the Preferences dialog box, click the E-mail tab.

3. Click E-mail System Setup.

4. Follow the instructions on the wizard pages. Click Next to advance. If you use Outlook e-mail with ACT!, the

wizard pages let you select options for recording history, attaching Outlook messages (Quick Attach) to ACT!

contacts, and sending activity invitations.

5. Click Finish.

If you use ACT! E-mail instead of Outlook, a default set of message folders (such as Deleted Items, Drafts, Inbox,

Outbox, and Sent Items) is created for each system you set up. You can organize and manage messages using the

folders in the Folder List. 

Word Processor Selection

In this section, you will learn about:

● Word processors you can use with ACT!.

● Selecting a word processor.

Word Processors You Can Use With ACT!

You can use the ACT! Word Processor or Microsoft Word 2002 (XP), 2003, and 2007 to create documents, such as

letters, memos, or fax cover sheets. ACT! provides document templates that you can use and modify. For more

information, see "How Can I Communicate Using ACT!?" on page 31.

The following explains how to select a word processor for writing letters and creating document templates.

Steps: Select a Word Processor

1. From the Toolsmenu, click Preferences.

2. Click the Communication tab.

3. From theWord Processor list, select a word-processing tool.

4. Click OK.
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Chapter 5: How Do I Keep Track of Contacts?

In this chapter, you will learn about:

● Contacts

● Groups

● Companies

Contacts

In this section, you will learn:

● About contacts.

● How to add contacts.

What Are Contacts?

A contact is a customer, business associate, friend, or anyone that you want to maintain a relationship with and keep

details about. A contact record includes information about the contact, such as name, address, phone number, e-mail

address, and so on. Contact information can also include notes, sales data, histories, attached documents, and personal

information such as birthday or spouse's name.

Other information you can enter and track for a contact includes:

● Assistant or secretary to the contact. This person is known as a secondary contact.

● Relationships between two or more contacts. Contact relationships lets you track information about relationships

between contacts who interact with each other.

For more information about secondary contacts and contact relationships, see Help.

You view and enter contact information on the Contact Detail view and Contact List. If you delete a contact, all

information stored in the record is deleted.

Adding Contacts

ACT! has several ways to add contacts to the database. The following explains one way to add a contact.

Steps: Add a contact

1. From the global toolbar, click the arrow next to New, and then click Contact.

A blank contact record appears.

2. Type or select information in the fields. Press TAB to move between fields. Enter as much or as little

information as you need.

● A field with a drop-down arrow contains a list. Click the arrow and select an item from the list, or type one

or two letters in the field. ACT! automatically completes the field with a matching item from the list.

● If an exclamation point appears, you need to change the entry in the field. Pause the pointer over the

exclamation point for more information.

● Use the ID/Status field to group contacts by categories. For example, you might have categories such as

Personal, Vendor, or Competitor. You can search for contacts by ID/Status.

3. To verify the contact name details, click the browse button (...) in the Contact field.

Note:Make sure that ACT! has correctly identified the contact's first name, last name, and title so that they will

be used correctly in letters. You can also set a preference for how salutations appear. See Help for more

information.

4. Add information using the tabs located at the bottom of the Contact Detail view. You can attach documents,

schedule an activity, write a note, make the record private, and so on. For more information, see Help.

ACT! automatically saves the contact record when you move to another record or view.
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Organizing and Working with Contacts

Organizing and Working with Contacts

ACT! includes several ways to organize and work with contacts:

● You can organize contacts who have something in common into a group. Groups are useful for working with

several contacts at once. For example, you create a group of all contacts that are customers and who have not

purchased from you in the last six months. You can prepare a new product brochure and send it to every contact in

that group. For more information, see "Groups" in the next section.

● If several of your contacts work for the same company, you can create a company record. An advantage of creating

company records is that you can link contacts to their companies and automatically update information between the

contact and company. For more information, see " Companies" on page 16.

Groups

In this section, you will learn:

● About groups and subgroups.

● How to create groups and subgroups.

● How to add contacts to groups.

What Are Groups and Subgroups?

You can organize contacts into groups so you can work with them more efficiently. A group is a collection of contacts

with something in common, such as all contacts who work on a particular project.

Groups let you:

● Communicate with all of the contacts in the group at once.

● Schedule activities with all of the contacts in the group.

● Share notes and histories with the group. (For more information about notes and histories, see "How Do I Keep

Details About Contacts?" on page 23.)

A group can have subgroups, which are subsets of the group. For example, you may have a group of contacts who

work on a project, and then have subgroups for contacts on specific teams within the project. Groups can include

unlimited subgroups and sub-subgroups that create a hierarchy. A group's hierarchy can be up to 15 levels deep. This

hierarchy displays in the Groups tree. Contacts can be members of multiple groups and subgroups.

You view, enter, and change group and subgroup information in the Group Detail view and Group List.

Note: To help you start using groups, when you create a new database, ACT! adds sample groups with group

descriptions. When you add a contact to the database, and then enter information into certain fields, the contact may

automatically be added to the group.

Creating Groups and Subgroups

ACT! has several ways to add groups and subgroups to the database. The following explains one way.

Steps: Create a group or subgroup

1. From the global toolbar, click the arrow next to New, and then click Group.

or

In the Groups tree, select the group you want to create a subgroup for. From the global toolbar, click the

arrow next to New, and then click Subgroup.

2. In the Group Name field, type a name for the group or subgroup.

Note: You can have duplicate group names. If you use duplicate names, it is a good idea to set the Duplicate

Checking preference. For more information, see Help.
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About Adding Contacts as Members of Groups

3. In the Description field, type a short explanation to help you identify the group. For example, you might type

"All contacts who work on XYZ Project".

Note: If an exclamation point appears, you need to change the entry in the field. Pause the pointer over the

exclamation point for more information.

4. Click Save.

The new group or subgroup appears in the Groups tree.

You can use the tabs to add contacts to the group or subgroup, schedule a group activity, attach documents,

make the group or subgroup private, and so on. For more information, see Help.

About Adding Contacts as Members of Groups

How you add contacts as members of a group depends on whether you want them to be in the group permanently or

only as long as they meet certain criteria.

● Contacts you add manually are static. This means they remain in the group until you remove them. For example,

you might have a group named Project Managers. You have selected contacts and added them to this group. If one

of these individuals changes jobs, you must manually remove them from the group.

● Contacts you add using query criteria are dynamic. Dynamic means they stay in the group as long as they meet the

criteria. For example, if a member moves out of the specified region, changing that information in the database

automatically removes the contact from the group. A query is a way of searching for information in the database

using logical expressions or conditions, such as Equal To or Contains. For more information about queries, see

"What Are Queries?" in Help and also see "How Do I Find Information?" on page 25.

The following explains how to add contacts to a group or subgroup.

Steps: Add contacts to a group or subgroup

1. Display the group or subgroup record.

2. Click the Contacts tab.

3. Click Add/Remove Contacts.

4. In the Add/Remove Contacts dialog box, use one or both methods to add contacts:

Manually

a. Click Contacts.

b. In the Select from list, select an option.

c. In the Look for field, type the first three letters of the contact's last name.

d. In the Contacts to select from list, select a contact from the list in the left pane. Click the right-arrow

button to move the contact to the Selected contacts list.

e. Add contacts as needed.

f. Click OK.

Using a Query

a. Under Dynamic members, click Edit Criteria.

b. In the Field Name field, select an item from the list.

c. In the Operator field, select an item from the list.

d. In the Value field, select an item from the list or type a value.

e. Click Add to list.

The criteria appear in the center pane.

f. To preview the contacts who meet the criteria and will be added to the group, click Preview.

g. To add criteria, repeat steps b - e. To change criteria, click the And/Or option.

h. When you are finished creating criteria, click OK to add the contacts as members. (You can also click Save

to save the query to use later.)

5. Click OK.
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Companies

Companies

In this section, you will learn:

● About companies and divisions.

● How to create companies and divisions.

● What is contact and company linking and how to link a contact to a company.

What Are Companies and Divisions?

A company record lets you track contacts associated with a company and provides other benefits for managing your

information. With companies, you can:

● Create a contact from a company record.

● Create a company from a group.

● Make contacts members of a company. You can view the contact's activities, notes, opportunities, and histories in

the company record. This also lets you send an e-mail message to all members of a company.

● Link contacts to companies. ACT! automatically adds the contact's activities, notes, opportunities, and histories to the

company record.

● Link contact and company fields and automatically update data between records.

Note: Adding contacts as members of companies lets you associate individuals with companies without linking them.

A company can have divisions and subdivisions which make up its hierarchy. A division might be a particular

department or a project. You can have an unlimited number of divisions and subdivisions, which appear in the

company hierarchy in the Companies tree. A company's hierarchy can have up to 15 levels. You can run reports and

see the information by a company's hierarchy.

You view, enter, and change company and division information in the Company Detail view and Company List.

Creating Companies and Divisions

ACT! has several ways to create a company and division. The following explains one way. (You create a company and

division the same way, except for the tool you click to start).

Steps: Create a company or division

1. From the global toolbar, click the arrow next to New, and then click Company.

2. In the Company field, type a name for the company.

3. Add other information as needed. If an exclamation point appears, you need to change the entry in the field.

Pause the pointer over the exclamation point for more information.

4. To create a division for the company:

a. From the global toolbar, click the arrow next to New.

b. Select Division.

c. Complete the information as needed.

The company or division appears in the in the Companies tree.

You can use the tabs to add contacts to the company or division, attach documents, make the company or

division private, and so on. The steps to add contacts to a company or division are same as adding contacts to

groups or subgroups. See "About Adding Contacts as Members of Groups" on the previous page.

What Is Contact and Company Linking?

ACT! lets you create associations, known as links, between contacts and companies. You can link a contact record to a

company record and link contact and company fields using Define Fields. The results of linking vary depending on the

type of link.

16 ACT! by Sage 2010

../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Creating Contacts from Companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Creating Companies from Groups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Creating Companies from Groups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Creating Companies from Groups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Creating Companies from Groups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Creating Companies from Groups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Companies/Creating Companies from Groups.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Adding contacts to groups or companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Adding contacts to groups or companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Adding contacts to groups or companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Adding contacts to groups or companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Adding contacts to groups or companies.htm
../../../../TechPubs_Head/ACT! 11.0 Help/Content/Contacts/Adding contacts to groups or companies.htm


Linking Contacts and Companies

Linking a contact record to a company record does the following:

● Automatically shares the contact's activities, notes, histories, and opportunities with its linked company.

● Lets you update the contact record with basic company information when you change company information.

You can link one contact at a time, or you can create a lookup of contacts and link them all to one company. The link

appears in the Company field of the Contact Detail view and in the Company column of the Contact List. You can click

the link to open the company record.

Tip: You can set a preference for automatically linking a contact to a company.

Linking contact fields to company fields automatically updates the contact field with information you change in the

company field. For example, you might link the contact Phone field to the company Phone field. Contacts will inherit

the phone number of the company they are linked to. If you change the phone number in the company record, the

change applies to every contact that is linked to that company. For more information, see Help.

Linking Contacts and Companies

The following explains how to link a contact record to a company record.

Steps: Link a contact to a company

1. On the Contact Detail view, click the browse button (...) next to the Company field.

The Link to Company dialog box appears.

2. From the View list, select Companies or Companies List.

3. From the list, select the company to link the contact to.

4. Click OK.

The linked contact is now a static member of the company. The linked contact's notes, activities, histories, and

opportunities appear in the linked company's tabs.
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Chapter 6: How Do I Schedule Appointments and Tasks?

In this chapter, you will learn about:

● Activities and how to schedule them.

● Calendars and the Task List and viewing activities on them.

● Recording completed activities.

Activities

In this section, you will learn:

● About activities.

● How to schedule activities.

● About recording completed activities.

What Are Activities?

Activities are appointments, such as meetings, and tasks, such as a job-related to-do item, that you need to schedule and

track. ACT! has several default activity types you can choose from to schedule your time. You can set personal

scheduling preferences for the activity types to make it quick and easy to schedule them. Also, you can create custom

activity types if the ACT! default types do not accommodate your scheduling needs.

ACT! activity types can help you:

● Set up a meeting to hold a presentation with a prospective customer.

● Schedule a telephone call with a customer.

● Track a to-do task, such as getting business cards printed.

To view a tour for this feature, from the Help menu, point to Feature Tours, and then click the tour name.

When you schedule an activity in ACT!, you must schedule it with at least one contact or user. You can select multiple

contacts. You can also schedule a personal activity with your My Record.

Other activity scheduling options you can select from include:

● Setting a time and date, making it timeless, or booking it as a full-day activity.

● Setting a reminder alarm and a priority level.

● Sending an iCalendar message to the invitees.

● Scheduling it as a recurring activity.

● Adding details about the activity and attaching an agenda, presentation, or other documents.

● Making it private, so that other ACT! users cannot see it. If another user views your calendar, the time for the private

activity shows "busy."

If you schedule activities using both your ACT! andMicrosoft Outlook calendars, you can integrate them for up-to-date

information in both places. You do not need to keep separate calendars. For more information, see "About ACT! and

Outlook Calendar Integration" in Help.

To help you easily schedule a series of related activities at set time intervals, you can use an activity series. For more

information, see "What Is an Activity Series?" in Help.
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Scheduling Activities

Scheduling Activities

ACT! has several ways to schedule an activity. The following explains one way.

Steps: Schedule an activity

1. From the global toolbar, select Call,Meeting, or To-do.

or

To schedule another type of activity, such as a vacation or custom activity, from the global toolbar, click the

arrow next to New, point to Other Activity. Select an activity from the list.

2. Complete the fields in each tab to select the attendees, send an iCalendar invitation e-mail, provide details and

attach a document, and more. (For more information about the fields and tabs, see "Scheduling Activities" in

Help.)

3. Click OK.

4. If ACT! finds a scheduling conflict, resolve it.

Recording Completed Activities

When you complete an activity, you can:

● Clear it from your schedule.

● Record history of the outcome.

● Schedule a follow-up activity.

Clearing an activity does not delete information about it. Clearing the activity marks it as completed (or not completed

depending on the outcome) and changes how it appears in ACT!. Depending on the preferences you set, activities that

you do not clear roll over to the next day so that you are reminded of them when you open ACT!. See Help for more

information.

Calendars and Task List

In this section, you will learn:

● About calendars.

● About sharing information between ACT! and Outlook calendars.

● About viewing activities on calendars.

● About the Task List.

What Are ACT! Calendars?

ACT! calendars display your scheduled activities, such as calls, meetings, and to-do items, on a day, work week, or

month view. You can view information about an activity, and use calendar filters to change what and how information

appears on your calendar. You can also view public activities for other users on your ACT! calendar. You can select

from ten or more users (Premium only).

Note: If you are viewing an activity for another user on your calendar and you do not have access to the contact the

activity is scheduled with, you can only view the date and time of the activity.

You can set calendar preferences to have completed activities appear on your calendar, specify the days of your work

week and working hours, and more. For example, you can specify a four-day work week that runs Monday through

Thursday, from 7AM to 4PM.

You can grant calendar access to other users so that they can schedule activities for you.

You can print your scheduled activities in a calendar format or the scheduled activities of another user. For more

information about printing a calendar, see "What Can I Print from ACT!?" on page 35.
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About ACT! and Outlook Calendar Integration

About ACT! and Outlook Calendar Integration

ACT! and Outlook calendar integration lets you schedule and view appointments, activities, and tasks in both your

ACT! andMicrosoft Outlook calendars. With calendar integration, you can:

● Schedule an ACT! activity upon accepting an iCalendar invitation in Outlook.

● Send an iCalendar e-mail invitation to Outlook recipients when scheduling an ACT! activity.

● Import Outlook items, such as contacts and notes, to an ACT! database.

To share information between ACT! and Outlook calendars, you must use Microsoft Outlook version 2002 (XP), 2003,

or 2007.

See Help for more information.

To view a tour for this feature, from the Help menu, point to Feature Tours, and then click the tour name.

Viewing Activities on Calendars

You can view and schedule activities using the calendars. The status bar at the bottom of each calendar displays the

number of activities shown, depending on the calendar view selected. You can use the filters, such as Types (of

activities) and Priorities, to change activities that appear on a calendar. The Select Users filter lets you view activities for

other users.

Viewing Days, Weeks, or Months

When you view a calendar, you can display the previous or next day, week, or month by clicking the Move Back or

Move Forward tools in the view toolbar. For more information, see "Calendar Tips" in Help.

Viewing Activity Details

On a calendar, to quickly see basic information for an activity, hold the mouse pointer over it. The activity's details

appear in a pop-up window. Details include the activity type, the contacts, the date and time, and so on. Ellipses

indicate there is more information than can appear in the pop-up window. An activity with multiple contacts displays

three rows of contact names. A plus sign (+) and ellipses after the last contact's name indicates that the activity is

scheduled with more contacts than can appear in the pop-up window.

To view all the details for an activity, double-click it.

What Is the Task List?

The Task List displays your activities for all dates and priorities. To access the Task List, from the Navbar, click Task

List. You can filter the list (that is, limit what appears on it). For example, you can limit it to meetings scheduled in the

current week.

From the Task List, you can:

● Export the data to Excel.

● Print the list, see "What Can I Print from ACT!?" on page 35.

● Schedule and clear activities.

● Filter the Task List to display other users' public activities (if you share a database with other users).

● Create a lookup of contacts the activities are scheduled with.

● Sort the list to show the activities in a particular order.

● Customize the list by adding, removing, or moving columns, changing fonts and colors, and so on.

The status bar shows the number of activities in the list, based on the filters applied. Use the scroll bars to view the list.
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Chapter 7: How Do I Keep Details About Contacts?

In this chapter, you will learn about:

● Notes and how to insert them.

● Histories and how to record them.

What Are ACT! Notes?

Notes are information that you want to refer to and track for a record. This information can include your observations

about a customer or prospect, personal and business information for a company and its contacts, and details of

conversations with a contact. For example, you talk to a contact who mentions he likes a particular restaurant. You can

enter that information as a note.

Each Detail view has a Notes tab.

● In the Contact and Opportunity Detail views, the Notes tab contains all notes for the contact or opportunity.

● In the Group and Company Detail views, the Notes tab contains all notes shared with the group or company and all

notes for contacts that are members of the group or company. (For more information about sharing notes, see

Help.)

You can view the contents of a selected note in the preview pane on the Notes tab. You can copy text from the preview

pane, but you cannot paste text into it. If a note contains an e-mail address, the address appears as a hyperlink. You can

click the hyperlink to send an e-mail.

ACT! has several ways to insert a note for a record. The following explains one way.

Steps: Insert a note

1. From the global toolbar, click Note.

2. Select or enter new information or keep the default information.

Note: You must select one contact or share the note with one group, company, or opportunity.

3. In the large text box below the formatting buttons, type the note details.

4. Click OK.

What Are Histories?

Histories record actions for a record and provide that information chronologically. ACT! automatically generates a

history when you perform an action, such as clearing a scheduled activity from your calendar, sending an e-mail

message (if you have set the record history option), opening a sales opportunity, and so on. ACT! can record a history

when you or another user changes data in a field. You can also manually record a history to document an action, such

as printing a letter or responding to an unscheduled call.

Each Detail view has a History tab.

● In the Contact and Opportunity Detail views, the History tab contains all histories for the contact or opportunity.

● In the Group and Company Detail views, the History tab contains all histories shared with the group or company

and all histories for contacts that are members of the group or company. (For more information about sharing

histories, see Help.)

You can view the contents of a selected history in the preview pane on the History tab. You can copy text from the

preview pane, but you cannot paste text into it. If a history contains an e-mail address, the address appears as a

hyperlink. You can click the hyperlink to send an e-mail.

ACT! has several ways to record a history. The following explains one way.

Steps: Record a history

1. From the global toolbar, click History.

2. In the Type field, select the type of history.

3. (Optional) In the Result field, select or type the outcome of the action.

Note: You must select one contact or share the history with one group, company, or opportunity.
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4. In the Date, Time, and Duration fields, keep the default entries or enter new information.

5. In the Regarding field, select or type a subject for the history.

6. In the Details text box below the formatting buttons, type details about the history item.

7. Click OK.
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Chapter 8: How Do I Find Information?

In this chapter, you will learn about:

● Methods for finding information in ACT!.

● How to use Dashboards to view information such as pending sales, tasks, and contact activity.

● ACT! reports and how to run one.

About Finding Information

You want to create a mailing list of your best customers. What is the quickest way to do this? Maybe you need to find

all your past customers so that you can contact them with a new product brochure. Do you need a list of all contacts

with something in common, such as everyone who lives in a specific city? Maybe you remember some information you

entered in a note, such as "sales proposal", but you cannot remember the contact's name. How can you find the contact?

What information do you have to work with – part of a name, a date? Do you need a map to a contact's address?

Would you like to find more information about a company?

ACT! has many methods for finding information. Some of these methods let you create lists from the search results.

You can find information in several ways:

● Lookups

● Keyword searches

● Queries

● Web Info tab

The following sections explain these methods.

Lookups

A lookup is a set of records resulting from a search or selection. For example, you want to create a mailing list of all

contacts that were referred to you by an advertisement. You can select the Referred by field and search on

Advertisement. The records that meet your lookup criteria appear in the appropriate list view. (If only one record

meets your lookup criteria, the detail view appears.) You can create a lookup by selecting records in a list. Also,

you can create a contact lookup from several views and tabs. For example, from the Task List, you can create a

lookup of contacts with scheduled activities. For more information, see "What Are Lookups?" in Help.

Keyword Searches

If you remember some information you entered into a note or history, but you do not remember the contact's

name, a keyword search lets you find records by searching words contained in their fields, notes, histories, and so

on. With your search results, you can create a set of records to work with. For more information, see "What Is

Keyword Search?" in Help.

Queries

Unlike a Lookup, which uses one criterion for finding information, you can use multiple criteria and conditions to

create an advanced query. ACT! uses the results of queries in several ways. Also, unlike a Lookup, you can save a

query to use it again. For more information, see "What Are Queries?" in Help.

Web Info tab 

The Web Info tab is an internal browser that lets you display Web pages specific to a contact or company. This tab

appears in the Contact and Company Detail views. Several links to popular search Web sites are provided, but

you can add your own links to Web pages. To use Web Info, you need an Internet account, an Internet Service

Provider (ISP), andMicrosoft Internet Explorer® version 6.0 or later. For more information, see "Learning About

Web Info" in Help.

To view a tour about finding information in ACT!, from the Welcome page, under Video Tutorials, click Finding

Information in ACT!.
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Finding Information Using Lookups

Finding Information Using Lookups

ACT! has several ways to find information using a lookup. The following explains one way - using the Lookup button

on the global toolbar. 

Steps: Find information using a lookup

1. From the global toolbar, click Lookup.

The record type field defaults to the view you started from. For example, if you start from the Contact List, the

record type field defaults to Contacts.

a. (Optional) If you need to search another record type, such as group records, click Show more options to

expand the dialog box.

b. In the Search for field, select a record type from the list.

2. From the Field list, select an item.

3. Keep the default condition (in the middle field) or select another one. (Depending on your field selection, the

middle field contains a suggested condition.)

4. In the remaining field, type the information to search for or select an item from the list.

5. Click OK.

Finding Information Using Web Info

The following explains how to find information about a contact or company using the Web Info tab.

Steps: Find information using Web Info

1. From a Contact Detail or Company Detail view, click theWeb Info tab.

2. Select a site from the list on the left.

The internal browser opens and displays a Web page for the selected site.

Tip: To add your own Web sites to the list, see "Customizing Web Information" in Help.

Dashboards

In this section, you will learn:

● About Dashboards and how to select one.

● How to filter components to find information.

Learning About Dashboards

Dashboards provide one location where you can view and work with important information, such as:

● Daily schedules.

● Lists of activities, such as appointments, meetings, and so on.

● Top opportunities.

● Sales figures.

● Data charts on your customers and contacts, sales opportunities and products, recent contact activity, remote

databases, and users.

You access a Dashboard by clicking the Dashboard button on the Navbar.

ACT! provides several default Dashboards. Each Dashboard has components that display different types of data. In

some components, you can click to navigate to another ACT! view and perform tasks like scheduling activities. You

can also filter components to change the display of data. To share information with others, you can copy and print

Dashboards. For more information, see "Learning About Dashboard Components" in Help.

You can use the Dashboard Designer to edit the default Dashboards and to create custom Dashboards.

To view a tour for this feature, from the Help menu, point to Feature Tours, and then click the tour name.
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Selecting Dashboards

Selecting Dashboards

You can select the Dashboard that appears when you click Dashboard on the Navbar. The following explains how to

do that.

Steps: Select a Dashboard

1. From the Navbar, click Dashboard.

2. From the view toolbar, from the drop-down list, select a Dashboard.

Learning About Dashboard Filters

You can filter (change) the data that appears in each Dashboard component by clicking the Filter button. For example,

in the My Schedule At-A-Glance component, you can filter to show activities and tasks for other ACT! users whose

data you can access (Premium product only). You can also select a different date range to show activities scheduled for

that time, select one or more activity types and priorities, and more.

ACT! saves your filter settings for each component until you change them. However, if another user changes the filters

in the Dashboard Designer or changes the data security rules in your database, your filters are overridden. For more

information, see "What Is the Dashboard Designer?" and "What Is Data Security?" in Help.

Reports

In this section, you will learn:

● About reports and report templates.

● About the Reports view and how to add a report to the Favorites list.

● How to run a report.

What Are ACT! Reports?

ACT! reports let you view and share information about contacts, opportunities, activities, calendars, and so on. ACT!

includes many reports that you can use to plan your schedule, analyze your business, and communicate with your

team.

The reports feature includes the Reports view and the Report Designer. The Reports view organizes and displays ACT!

reports available in the current database or any other ACT! database you have access to. The Report Designer lets you

create and edit report templates.

Tip: In ACT!, mailing labels and envelopes are reports, which you can customize. To print a mailing label or envelope

using the default templates, see "What Can I Print from ACT!?" on page 35.

Report Templates

A report is based on a template, which determines its structure and formatting. You can create filters in templates that

determine the type of information provided in the report, such as activities or histories, a date range of the records,

and so on. You can create or customize report templates using the Report Designer. For more information, see "About

report templates and the Report Designer" in Help.

Learning About the Reports View

The Reports view is where you manage and run ACT! reports. To open the Reports view, from the Navbar, click

Reports.

From this view, you can:

● Display, run, and delete reports. (Deleting reports is only available to users with Standard and above roles.)

● Keep a list of your favorite reports.

● Change report names and descriptions.

● Open reports for editing in the Report Designer.
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Keeping a List of Favorite Reports

When you create a new report and save it to the database, it is added to the Reports view. All users that access the

database can see the report.

Favorite Reports

The Favorite Reports list is a convenient place to store and run reports you use frequently. Reports you mark as

favorites appear in the Favorite Reports list at the top of the Reports view. The reports you select as favorites are your

personal selections. Other users do not see your Favorite Reports list. You can remove reports from the Favorite

Reports list at any time.

Report List

The Report List shows all reports you have access to in the current database. From the Report List, you can run, edit,

and delete reports. It is from this list that you mark reports as favorites so they appear in the Favorite Reports list.

Report Names and Descriptions

The Reports view displays a name and description for each report. The description appears in a column in the Favorite

Reports and Reports List. If you have permission to edit reports, you can change report names and descriptions.

Keeping a List of Favorite Reports

The following explains how to add a report to your Favorite Reports list.

Steps: Add a report to the Favorite Reports list

1. From the Navbar, click Reports.

2. Select the Favorites check box next to the report.

The report is added to your Favorite Reports list.

Running Reports

The following explains how to run a report. You can use the report filters to specify the data to include in the report.

You can preview a report to make sure it contains the information you want before you print it.

Steps: Run a report from the Reports view

1. From the Navbar, click Reports.

2. From the Favorite Reports or Report list, double-click the report.

3. In the Define Filters dialog box, specify the output for the report (printer, preview, etc.) and the data to

include in it.

Note: The tabs that appear (Activity, Note, History, or Opportunity) and the information in those tabs depend

on the type of report you selected. The General tab always appears so that you can select an output for the

report and the records to include in the report.

4. Click OK.
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Chapter 9: How Can I Track My Sales?

In this chapter, you will learn about:

● Sales opportunities including sales processes and stages, and products and services.

● How to create sales opportunities.

What Are Opportunities?

An opportunity is a potential sale. Tracking your opportunities in ACT! lets you:

● Use ACT! sales processes, or your own, to manage leads from the initial request to closing the sale.

● Add your products or services.

● Create and print quotes.

● Schedule activities, such as a meeting, with all parties involved in the decision-making process.

● Include other information about the transaction, such as notes, and attach documents.

● Report on your sales using the included ACT! opportunity reports.

You view, enter, and change opportunity information on the Opportunity Detail view and the Opportunity List.

To view a tour for this feature, from the Help menu, point to Feature Tours, and then click the tour name.

Sales processes and stages

In ACT!, a sales process is a series of stages that let you determine how close you are to winning a sale. ACT! includes

several default sales processes to help you get started managing your sales opportunities. You can customize these

processes or create new ones to suit your needs.

Each stage of a process has an associated probability for closing. The probability, along with the total value of products

and services, determines the weighted value of the opportunity.

You can change the stages or adjust the probabilities if they do not accurately reflect how close you are to winning the

sale. You can run reports and view your opportunities' pipeline in graphs by stages.

Products and services

Costs and prices associated with products and services can determine the value of your opportunity. ACT! includes

several ways to help you manage and customize your products and services list. You can select products and services

from a list or add them by typing them in the opportunity's Products/Services tab. (To add a product or service to the

master list so it is available for all opportunities, you must be an Administrator or Manager of the database.)

Creating Sales Opportunities

ACT! has several ways to create (open) a sales opportunity. The following explains one way.

Steps: Create a sales opportunity

1. From the global toolbar, click the arrow next to New, and then click Opportunity.

The Opportunity Detail view appears with several fields automatically filled. Some of these fields let you change

the information in them.

2. Complete the remaining fields and boxes to give the opportunity a name, set a status, and apply a sales process

and stage.

3. Add other information as needed, such as:

● Associate a primary contact (or contacts), groups, or companies with the opportunity.

● Add products and services to the Products/Services tab.

● Record notes and histories.

● Schedule activities associated with the opportunity.
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Chapter 9: How Can I Track My Sales?

● Attach documents.

● Make the opportunity private or add competitors and referrals.

4. Click Save.

Tip: If you have Microsoft Word installed, you can click the Quote button to generate a quote for the

opportunity that you can send to the primary contact. For more information, see "Creating Quotes for

Opportunities" in Help.
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Chapter 10: How Can I Communicate Using ACT!?

ACT! has many ways for you to communicate with your contacts—e-mail, letters, faxes, phone (using the Dialer), and

so on.

In this chapter, you will learn about:

● Sending e-mail from ACT!.

● Writing letters and other documents.

For information about using the Dialer, see Help.

E-mail

In this section, you will learn about e-mail and how to send e-mail from ACT!. You will also learn how to send a

contact's electronic business card (vCard) from ACT!.

About E-mail

In ACT!, you can either use the included e-mail system (with an Internet account), or you can use another e-mail

system, such as Microsoft Outlook.

Besides sending and receiving e-mail, you can:

● Attach contact, group, or company records to e-mail messages you send. You can also attach e-mail messages to

contact, group, or company records.

● Send a contact's electronic business card (vCard).

● Attach files to e-mail messages you send.

● Create a new contact record from the sender's information.

● Create an activity.

● Record a history of the e-mail to contact, group, and company records.

● Make the history private, so other ACT! users cannot see it.

Writing and Sending E-mail Messages

The following explains how to write and send an e-mail message to a contact.

Steps: Send an e-mail message

1. On the Contact Detail view, click the contact's e-mail address.

The message window appears with the recipient's name in the To field.

2. To send a copy of the e-mail to other recipients:

a. Click To, Cc, or Bcc.

b. From the dialog box that appears, select names from the list on the left. Click To, Cc, or Bcc to add the

names. Click OK.

3. In the Subject field, type a short description of the message.

4. Select options: Priority, Create History,Make history private, or Return receipt.

Note: To set a default History option, see "Setting preferences - e-mail composing options" in Help.

5. In the text box, type your message.

6. To format the text, click the Format menu. Select HTML, and then format text. (You cannot format Plain Text.

You can set a preference to specify a default text format.)

7. To insert a signature, click the Insert Signature tool.

8. Use the menus and toolbars to:

● Check recipient names.

● Check spelling.
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Sending a vCard

● Attach records.

● Attach files.

● Insert graphics or hyperlinks.

9. Click Send.

Sending a vCard

The following explains how to send (export) a contact's electronic business card (vCard) from ACT!.

Steps: Send a contact's vCard

1. Open a Contact Detail view.

or

From the Contact List, select multiple contacts.

2. From the Contactsmenu, click Send vCard.

Your selected e-mail application opens with the attachment(s).

3. Send the vCard in an e-mail message.

Letters and Documents

In this section, you will learn about:

● The types of documents you can create in ACT!.

● Document templates and how to select them.

● How to create documents.

About Writing Letters and Documents

In ACT!, you can create documents, such as letters, memos, or fax cover sheets. You can use the ACT! Word Processor

or Microsoft Word versions 2002 (XP), 2003, or 2007. With ACT! documents, you can:

● Create and personalize letters or other documents to send to one or more contacts.

● Create and edit templates (templates are described later in this chapter).

● Format documents, including adding bulleted and numbered lists, using bold or italics, inserting headers or footers,

and so on.

● Insert files, images, and hyperlinks in documents.

● Check spelling in documents.

● Print, fax, or e-mail completed documents.

ACT! Document Templates

ACT! has default document templates for writing a letter, memo, fax cover page, direct marketing letter, negotiation

follow-up, and so on. The templates are available in ACT! Word Processor (TPL) andMicrosoft Word (ADT) formats.

You access the default e-mail, letter, memo, and fax cover page templates from the Write menu. For the list of default

document templates, see Help.
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Creating Documents

When you select an item from the Write menu, such as Letter, the default document template for a letter appears in

your selected word processor. The following explains how to choose other document templates.

Steps: Select a document template

1. From theWritemenu, click Other Document (from template).

2. In the dialog box that appears, select a template from the list.

3. Click Open.

Note: If the template does not appear in the list, from the Look in list, browse to the location of the template.

Also, check that the Files of types is set to Templates (*.tpl).

Creating Documents

You can create a document for one contact or use mail merge to create a document for several contacts. The following

explains how to create a document for one contact. For information on using mail merge, see Help.

Steps: Create a document for one contact

1. Display the contact's detail view.

2. From theWritemenu, click Letter,Memo, or Fax Cover Page (or click Other Document and select a

template).

The contact's information, such as name and address, appears in the document.

3. Type text in the body of the document. You can also change the template's text or formatting.

4. Click the Save tool.

Note: If you use Word 2007, you may want to select the option to Maintain compatibility with Word 97-2003.

5. Print, fax, or e-mail the document.

Note: You can print labels and envelopes with the contact's information on them. You create labels and

envelopes using a report template.
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Chapter 11: What Can I Print from ACT!?

You can print many kinds of information, such as views, lists, reports, labels and envelopes, from ACT!. This chapter gives

the steps to print several items, such as:

● Address books

● Calendars

● Dashboards

● Detail views

● Documents, such as letters

● E-mail messages

● Labels or envelopes

● List views

● Reports

● Task List

For more information about all the items you can print from ACT!, see "Printing" in Help.

In most cases, the easiest way to print is to use the Quick Print tool on the toolbar. This prints the view you currently have

displayed.

Printing

The following explains how to print information from ACT!. Depending on your printer, you may be able to choose options

to change the font size or the orientation from portrait to landscape for the item you print. See your printer's

documentation.

Address Book of Contacts

1. Create a lookup of contacts to include in the address book.

2. From the Filemenu, click Print.

3. From the Printout type list, select Address Book.

4. From the Paper type list, select the paper type.

5. To preview how the address book will look, select the .Preview check box.

6. To include data from other fields and to set options, click the Options button. Select options as needed.

7. Click Print.

8. In the Print dialog box, in the Name list, select a printer.

9. Click OK.

Calendars

1. Display a calendar view (Monthly, Daily, and so on).

2. (Optional) To print a calendar for another user, click the Select Users button (above the calendar's date) to choose

the user.

3. From the view toolbar, click the Print tool.

a. In the Quick Print Options dialog box, change options as needed.

b. Click OK.

Dashboards

1. Display a Dashboard.

2. From the view toolbar, click the Print tool.

a. In the Quick Print Options dialog box, change options as needed.

b. Click OK.
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Printing
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Detail Views

1. Display a Detail view.

2. From the view toolbar, click the Print tool.

a. In the Quick Print Options dialog box, change options as needed.

b. Click OK.

Documents

1. Write a letter or other document.

2. Do the following:

● ACT! word processor: From the Filemenu, click Print. Or, point to Send, and then click Fax.

Note: To fax from ACT!, you must have fax software installed and set up for use with ACT!. See "Setting Up Fax

Software" in Help.

● Microsoft Word XP or 2003: From the Filemenu, click Print.

● Microsoft Word 2007: Click the Office button. Select Print.

3. Depending on your printer, choose additional options, such as orientation or page size. In the Print dialog box, click

Properties or Preferences. Choose print options. Click OK.

4. If your printer requires it, click Print.

5. Click OK.

E-mail messages

1. From the E-mail window, select a message in the message list or open a message.

2. Click the Print tool.

3. In the Print dialog box, click OK.

Labels or envelopes

1. Create a lookup of contacts.

2. From the Filemenu, click Print.

3. From the Printout type list, select Labels or Envelopes.

4. From the Paper type list, select a label or envelope type. Click Print.

5. In the Define Filters dialog box, select options to filter the data for the labels or envelopes. Click OK.

6. Insert the labels or envelopes into the printer. On the Print Preview window, click Print. Click OK.

7. Click Print.

List views

1. Perform a lookup of records in a list view before printing.

● For Groups or Companies: To include all subgroups or divisions: On the Group List or Company List, select

Include subgroups or Include divisions.

2. (Optional) Select rows to print:

● Contact List: Select Tag Mode. Click each row to include in the printed list.

● Group or Company List: Select the first row to include, press and hold CTRL, and then select the other rows.

To print a group of consecutive rows: Select the first row, press and hold SHIFT, and then click the last row.

● Opportunities List: (Optional) Filter the list. You can also select rows as described in the Group or Company

List option.

3. From the view toolbar, click the Print tool.
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a. In the Quick Print Options dialog box, change options as needed.

b. Click OK.

Reports

1. From the Navbar, click Reports.

2. From the Favorite Reports or Reports List, select the report.

3. From the view toolbar, click Run Report.

4. On the General tab, under Send the report output to, select Printer.

Note: You can preview a report before printing it.

5. Click OK.

6. In the Print dialog box, in the Name list, select a printer. If you are faxing the report, select the fax software. Click

OK.

The Task List

1. From the Navbar, click Task List.

2. Filter the display as needed.

3. From the view toolbar, click the Print tool.

a. In the Quick Print Options dialog box, change options as needed.

b. Click OK.
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